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Understanding Altera FPGA Pin Terminology
Altera FPGA devices are available in a variety of packages to meet all of your complex 
design requirements. To describe Altera FPGA pin terminology, this chapter uses a 
wire bond ball grid array (BGA) package in its examples. On the top surface of the 
silicon die, there is a ring of bond pads that connect to the I/O pins of the silicon. In a 
wire bond BGA package, the device is placed in the package and copper wires 
connect the bond pads to the solder balls of the package. Figure 5–1 shows a cross 
section of a wire bond BGA package.

f For a list of all BGA packages available for each Altera FPGA device, refer to the Altera 
Device Package Information Data Sheet.

Package Pins
The pins of a BGA package are small solder balls arranged in a grid pattern on the 
bottom of the package. In the Quartus II software, the package pins are represented as 
pin numbers. The pin numbers are determined by their locations using a coordinate 
system with letters and numbers identifying the row and column of the pins, 
respectively.

The upper-most row of pins is labeled “A” and continues alphabetically as you move 
downward (Figure 5–2). The left-most column of pins is labeled “1” and continues 
with increments of 1 as you move to the right. For example, pin number “B4” 
represents row “B” and column “4.”

The letters I, O, Q, S, X, and Z are never used in pin numbers. If there are more rows 
than letters of the alphabet, the alphabet is repeated, prefixed with the letter “A.”

f For more information about the pin numbers for your Altera device, refer to the 
device pin-out information available on the Altera website at www.altera.com.

Figure 5–1. Wire Bond BGA
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Pads
Package pins are connected to pads located on the perimeter of the top metal layer of 
the silicon die (Figure 5–1). Each pad is identified by a pad ID, which is numbered 
starting at 0, incrementing by 1 in a counterclockwise direction (Figure 5–3).

To prevent signal integrity issues, the Quartus II software uses pin placement rules to 
validate your pin placements and pin-related assignments. It is important that you 
understand which pad locations your pins were assigned to, because some pin 
placement rules describe pad placement restrictions. For example, in certain devices, 
there is a restriction on the number of I/O pins supported by a VREF pad to ensure 
signal integrity. There are also restrictions on the number of pads between 
single-ended input or output pins and a differential pin. The Quartus II software 
performs pin placement analysis, and if pins are not placed according to pin 
placement rules, the design compilation fails and the Quartus II software reports an 
error.

f For more information about pin placement guidelines, refer to the Selectable I/O 
Standards chapter in volume 1 of the appropriate device handbook.

I/O Banks
I/O pins are organized into I/O banks designed to facilitate various supported I/O 
standards. Each I/O bank is numbered and has its own voltage source pins, called 
VCCIO, to offer the highest I/O performance. Depending on the device and I/O 
standards for the pins within the I/O bank, the specified voltage of the VCCIO pin is 
between 1.5 V and 3.3 V. Each I/O bank can support multiple pins with different I/O 
standards that share the same VCCIO.

It is important to refer to the appropriate device handbook to determine the 
capabilities of each I/O bank. For example, the pins in the I/O banks on the left and 
right side of a Stratix® II device support high-speed I/O standards such as LVDS, 
whereas the pins on the top and bottom I/O banks support all single-ended I/O 
standards, including data strobe signaling (DQS) (Figure 5–4). Pins belonging to the 
same I/O bank must use the same VCCIO signal.

Figure 5–3. Pad Number Ordering

29 28 27 ...

...

0

1

2

3

Altera
Silicon Die
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization



5–4 Chapter 5: I/O Management
Understanding Altera FPGA Pin Terminology
 

VREF Groups
A VREF group is a group of pins that includes one dedicated VREF pin as required by 
voltage-referenced I/O standards. A VREF group is made up of a small number of 
pins, as compared to the I/O bank, to maintain the signal integrity of the VREF pin. 
One or more VREF group(s) exist in an I/O bank. The pins in a VREF group share the 
same VCCIO and VREF voltages. 

f For more information about I/O banks, VREF groups, and supported I/O standards, 
refer to the Architecture and Selectable I/O Standards chapters in the appropriate device 
handbook.

Figure 5–4. Stratix II I/O Banks (Note 1), (2), (3), (4)

Notes to Figure 5–4:

(1) This figure shows a top view of the silicon die that corresponds to a reverse view for flip chip packages. It is a 
graphical representation only.

(2) Depending on the size of the device, different device members have a different number of VREF groups. Refer to the 
pin list and the Quartus II software for exact locations.

(3) Banks 9 through 12 are enhanced phase-locked loop (PLL) external clock output banks.
(4) Horizontal I/O banks feature serializer/deserializer (SERDES) and dynamic phase alignment (DPA) circuitry for 

high-speed differential I/O standards. For more information about differential I/O standards, refer to the High-Speed 
Differential I/O Interfaces with DPA in Stratix II and Stratix II GX Devices chapter in volume 2 of the Stratix II Device 
Handbook.
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I/O Planning Overview
I/O planning of your FPGA design in Quartus II software includes:

■ Selecting a device that meets your logic and I/O requirements, based on the 
device’s supported I/O standards, I/O bank structure, supply voltage 
requirements such as VREF and VCCIO requirements in I/O banks, available pins 
for user I/O, power supply requirements, and more.

■ Getting your design files ready. The design files contain the top-level ports or 
top-level interface information. If you do not have the design files, you can use the 
Early I/O Planning flow to generate a top-level HDL wrapper file.

■ Importing any existing assignments from a Tcl script, .csv, or .qsf file.

■ Creating, modifying, and completing all pin-related assignments that include pin 
location assignments, I/O standards, output loading assignments for output and 
bidirectional pins, slew rates, current strengths, and more.

■ Validating your pin-related assignments while creating them by using the Live 
I/O Check feature, then running I/O assignment analysis, and finally running the 
Fitter with timing constraints.

■ Generating a validated *.pin file for third-party PCB tools.

The method you use to create pin assignments depends on your requirements. If you 
have not yet designed the PCB, create and validate your I/O assignments in the 
Quartus II software, then export them to the PCB tool (Figure 5–5). This is the 
recommended design flow for creating I/O assignments for an FPGA design.
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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Figure 5–5. Quartus II Software I/O Planning Flow

Notes to Figure 5–5:

(1) Use the Live I/O Check feature in the Pin Planner to validate pin assignments as you create them.
(2) To create the FPGA Xchange file (.fx), on the Processing menu, point to Start and click EDA Netlist Writer. The .pin file is created at the 

<project_dir> level. The .fx file is created at the <project_dir/board/.../> level.
(3) Your design files and constraints must be complete before you begin full compilation. To learn how to create I/O timing constraints, refer to the 

TimeQuest Timing Analyzer and Classic Timing Analyzer chapters in the Timing Analysis section in volume 3 of the Quartus II Handbook.
(4) Refer to the Area and Timing Optimization chapter in volume 2 of the Quartus II Handbook.
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If your PCB is partially designed, create your FPGA assignments in your PCB tool and 
import them into the Quartus II software for validation (Figure 5–6).

1 Currently, only the Mentor Graphics® I/O Designer PCB tool and the Cadence Allegro 
PCB tool are supported in this reverse I/O planning flow.

You must refer to the appropriate device handbook, available on the Altera website at 
www.altera.com to learn about the I/O architecture, supported I/O standards, and 
their requirements in your device. In the Quartus II software design flow, the most 
important step in I/O planning is to create, modify, complete, and validate pin-related 
assignments. The Quartus II software includes the Pin Planner and I/O Assignment 
Analysis to assist you in I/O planning.

Device Selection
Before you begin pin planning or I/O assignment analysis in the Quartus II software, 
refer to the device handbooks at www.altera.com to understand the I/O structure, 
supported I/O standards, available pins for user I/O, clocking schemes and options, 
and I/O bank structure for different devices. Then, choose an appropriate device from 
a supported device family for your design. To select a device, on the Assignments 
menu, click Device to open the Settings dialog box (Figure 5–7). In the Family list, 
select the device. You can set the other controls under Show in ‘Available devices list’ 
to filter the Available devices list and to select any migration devices. Under the 
Available devices list, select a device. 

Figure 5–6. I/O Planning Flow Using an FPGA Xchange File from a PCB Tool
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Early I/O Planning Using the Pin Planner
It might be difficult to plan your I/Os early in the design cycle because the design 
files, including the top-level design, might not be available yet. However, the 
interfaces between your FPGA and other devices are typically determined and 
documented in the design specifications. By adding those interfaces required to 
connect your FPGA with these other devices in the Pin Planner, you can plan your 
FPGA I/Os efficiently without design files. The Early I/O Planning flow allows you 
to create a top-level wrapper file in Verilog HDL or VHDL. The flow includes 
importing and/or creating any Altera IP MegaCore® functions or Altera 
megafunctions in the Pin Planner, as well as creating or adding additional top-level 
pins information, configuring the top-level pins of the design, and creating the 
top-level HDL file.

Creating a top-level file using the Early I/O planning flow is an optional step in your 
I/O planning. If you have design files that have complete information about the 
top-level interfaces and ports, you can skip the Early I/O planning flow step and 
proceed to making pin-related assignments. The top-level file you create using the 
Early I/O planning flow serves as the top-level file for your Quartus II software 
project. If you do not use the Early Pin Planning flow to create a top-level HDL file, 
you must analyze and elaborate your design files in the Quartus II software before 
importing or modifying your pin assignments.

Figure 5–7. Device Page of the Settings Dialog Box
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation
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The following sections describe the typical steps involved in the early I/O planning 
flow to generate a top-level wrapper file in Verilog HDL or VHDL: 

■ “Create or Import a Megafunction or IP MegaCore Variation from the Pin Planner”

■ “Configure Nodes” on page 5–10

■ “I/O Analysis for Designs with Pins Only” on page 5–14

Create or Import a Megafunction or IP MegaCore Variation from the Pin Planner
The Pin Planner can interface with the MegaWizard™ Plug-In Manager, allowing you 
to create or import custom megafunctions and intellectual property (IP) cores. You can 
add many types of interfaces, including megafunctions such as ALTPLL and 
ALTDDIO, and IP MegaCore functions such as PCI Compiler, QDR II, and RapidIO. 
Adding the interface information while planning your I/Os allows you to assign each 
required pin without manually creating each pin individually in the Pin Planner. 
Furthermore, you can add and configure your own user ports that are top-level ports 
in your design.

You can create or customize some megafunction variations from within the Pin 
Planner. When you do this, some of the pin assignments of the top-level pins of the IP 
MegaCore function or megafunction get transferred to the Pin Planner. To create a 
megafunction or IP MegaCore variation from the Pin Planner, perform the following 
steps:

1. In the Pin Planner, right-click anywhere in the Groups list or All Pins list.

2. On the shortcut (right-click) menu, click Create/Import Megafunction. The 
Create/Import Megafunction dialog box appears. You can also open this dialog 
box from the Edit menu or directly from the Toolbar.

3. To create a new megafunction, select Create a new custom megafunction and click 
OK. The MegaWizard Plug-In Manager appears.

4. In the list of supported megafunctions and IP MegaCore functions, select the 
megafunction or IP MegaCore function you want to create and complete the 
MegaWizard Plug-In Manager pages.

5. After you complete the wizard, a new group, based on the file name you provided, 
is created and all the I/O names, directions, and I/O standards are listed as 
members of the group in the Groups list. Any IP megafunction that has a pin 
planning file (.ppf) can be imported to the Pin Planner. 

f For more information about a particular megafunction, refer to the appropriate 
megafunction user guide, available on the User Guides literature page of the Altera 
website.

Besides creating an IP MegaCore function or megafunction variation directly from the 
Pin Planner, you can import an IP MegaCore function’s or megafunction’s .ppf file 
into the Pin Planner. This would import a .ppf file when you have generated a 
MegaCore function or megafunction variation and its .ppf file.
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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Or

You have generated the variation in the Pin Planner and want to import its .ppf in the 
Pin Planner for other instances of the same variation. When you import an existing 
.ppf file into the Pin Planner, you have to provide a unique instance name so that in 
the final top-level HDL, all instances of the same variation remain unique.

To import a megafunction variation to the Pin Planner, perform the following steps:

1. In the Pin Planner, right-click anywhere in the Groups list or All Pins list.

2. On the right-click menu, click Create/Import Megafunction. The Create/Import 
Megafunction dialog box appears. You can also open this dialog box from the Edit 
menu.

3. Select Import an existing custom megafunction and click the browse button. 
Select the Pin Planner File (.ppf) that was generated along with your megafunction 
variation or your IP MegaCore files.

4. In the Instance name box, type in an instance name and click OK. 

1 To avoid pin name conflicts when there is more than one instance of a 
megafunction or IP MegaCore function, the instance name is appended to 
the beginning of each pin name.

When the wizard is complete, a new group based on the file name you provided is 
created and all the I/Os that are used externally are listed as members of the group.

Configure Nodes
Before you create a top-level design file, you must first configure the user ports, 
megafunction nodes, and IP MegaCore function nodes created in the Pin Planner for 
integration with each other and the rest of the design. This step is similar to making 
connections in a schematic.

Configure Megafunction Nodes
After creating or importing custom megafunctions or IP MegaCore functions in the 
Pin Planner, you must configure how they will be connected to each other. You do this 
by specifying matching node names for selected ports of the megafunctions or IP 
MegaCore functions.

1 In this section, ports and port names refer to the generic port names of megafunctions 
and IP MegaCore functions in the MegaWizard Plug-In Manager. Node names refer to 
the unique names assigned to ports when the megafunction or IP MegaCore function 
is created based on the instance name given when the MegaWizard Plug-In Manager 
is started. By default, node names are the original port names prefixed with 
<instance name>_.

To configure your custom megafunctions and IP MegaCore functions for creating a 
top-level design file, on the Edit menu of the Package View, click Set Up Top-Level 
Design File. The Set Up Top-Level Design File dialog box appears (Figure 5–8).
Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization © March 2009 Altera Corporation
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Click the name of a megafunction or IP MegaCore function in the list on the left. The 
list on the right contains all the ports for the selected megafunction.

The columns in the Set Up Top-Level Design File dialog box provide information 
about megafunctions created in or imported to the Pin Planner and allow you to make 
adjustments to connect megafunctions together. The Direction column indicates the 
direction of the port or port group as defined by the megafunction. The direction of a 
port cannot be changed.

The Type column indicates whether a port is available externally to the device. By 
default, all ports on all megafunctions created through the Pin Planner are of the 
External type, meaning they appear in the Groups list and All Pins list and can be 
assigned to I/O pins. You can change the port type by double-clicking the cell in the 
Type column for a port and selecting Internal or External from the list. Any ports on 
any megafunction connected to a port that has its type changed have their type 
changed to match automatically. This prevents internal and external megafunction 
ports from being connected to each other accidentally. Internal ports do not appear in 
the Groups list or All Pins list. If all the ports of a megafunction are internal, the 
megafunction does not appear in the Groups list.

The Node Name column is used to assign node names or device pins to ports. To 
connect a port to an existing location, double-click the cell in the Node Name column 
and select an existing node or device pin. To rename the selected port, enter a new 
node name in the Node Name column. This procedure only changes the name as it 
appears as a group member in the Groups list. To connect ports to each other, enter a 
node name that matches the node name of the ports of other megafunctions or an 
existing node.

Figure 5–9 shows an example of the port names of the DDIO_OUT megafunction.

Figure 5–8. Set Up Top-Level Design File Dialog Box
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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To edit the megafunction or IP MegaCore function you created in the Pin Planner, 
select it in the Groups list. On the Edit menu, click Edit Megafunction to reopen the 
MegaWizard Plug-In Manager and make changes as necessary. If you make changes 
to a megafunction, you must import it again and reconfigure its node connections in 
the Set Up Top-Level Design File dialog box.

1 If you edit the megafunction outside of the Pin Planner, you must re-import its .ppf 
file to the Pin Planner.

Configure User Nodes
If you use the Early I/O Pin Planning flow and start with a top-level file, either 
complete or partial, and analyze and elaborate that file in Quartus II software, all the 
top-level pins in that file appear under User Nodes, as shown in Figure 5–10. If you 
do not have any top-level files, you will not see any top-level node names under User 
Nodes.

Figure 5–9. Port Names of the DDIO_OUT Megafunction

Figure 5–10. User Nodes
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You can add new or additional nodes in the Set-Up Top Level Design File window. To 
create a new node, double-click in the <<new node>> row and enter the new node’s 
name. When you generate the top-level file in HDL, the new or additional nodes 
appear as ports in your HDL file. 

Each user node is associated with a node name and a direction. The direction is input, 
output, bidirectional, or unknown. If you do not select a direction, the node’s 
direction is unknown. When you enter new node names in this window, the All Pins 
list and Groups list in the Pin Planner are also updated.

The user nodes are also displayed when you configure node names for 
megafunctions. For example, to connect a user node named reset to a megafunction’s 
reset input port, in the Node Name column, select reset to make this connection, as 
shown in Figure 5–11.

When the port types and node names for both the input and output megafunctions 
and user nodes are configured as in Figure 5–8 on page 5–11, Figure 5–9 on page 5–12, 
and Figure 5–11, they create a circuit similar to the one shown in Figure 5–12. In this 
way, you can connect megafunctions to each other and to other nodes in the design, 
improving the thoroughness of an I/O assignment analysis. This is especially useful 
for clock networks that are typically attached to multiple megafunctions or IP 
MegaCore functions.

Figure 5–11. Connecting a User Node to a Megafunction Port
© March 2009 Altera Corporation Quartus II Handbook Version 9.0 Volume 2: Design Implementation and Optimization
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I/O Analysis for Designs with Pins Only
You can create a top-level design file after you add or modify user ports, 
megafunction nodes, or IP MegaCore function nodes in your project with the Pin 
Planner. Whether the internal logic is complete or not, the top-level design file enables 
you to validate your I/O assignments and provides a base on which to build the rest 
of your design.

After you configure the user nodes, megafunctions, and IP MegaCore functions 
created in the Pin Planner, you must create a top-level design file in an HDL format. 
Use this file as the basis for the rest of your project and use it to validate the I/O 
assignments.

To generate a top-level design file, right-click in the Package View and click Create 
Top-Level Design File. You can also generate a top-level file on the File menu by 
pointing to Create/Update and clicking Create Top-Level Design File From Pin 
Planner. The Create Top-Level Design File dialog box appears. Enter a name and 
select an HDL format (Verilog HDL or VHDL). If the file already exists, you can 
choose to create a backup of the original file. 

Example 5–1 shows a sample of an top-level HDL wrapper file as depicted in 
Figure 5–12.

Figure 5–12. Connections between Input and Output Megafunctions and User Nodes (Note 1)

Note to Figure 5–12:

(1) Gray pins indicate internal nodes of the design.
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inclock

aclr

datain_h[7..0]

datain_i[7..0]

outclock

aclr

dataout_h[7..0]

dataout_i[7..0]

dataout[7..0]
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The top-level HDL file contains all the top-level pins. When any internal type nodes 
are not connected to any logic inside the design, they appear in the port list of the 
top-level file, but are declared as virtual pins. The lines of code in Example 5–2 show 
examples of virtual pins in the top-level HDL file.

Example 5–1. HDL Wrapper File Generated with the Early I/O Planning Flow

module top
(

reset,
input_data,
clk,
output_data,
ddio_in_dataout_h, // Internal
ddio_in_dataout_l, // Internal
ddio_out_datain_h, // Internal
ddio_out_datain_l // Internal

);

input reset;
input[7:0]input_data;
input clk;
output[7:0]output_data;

output[7:0]ddio_in_dataout_h /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
output[7:0]ddio_in_dataout_l /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
input[7:0]ddio_out_datain_h /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
input[7:0]ddio_out_datain_l /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;

ddio_in ddio_in_inst
(

.aclr(reset),

.datain(input_data),

.inclock(clk),

.dataout_h(ddio_in_dataout_h),

.dataout_l(ddio_in_dataout_l)
);

ddio_out ddio_out_inst
(

.aclr(reset),

.datain_h(ddio_out_datain_h),

.datain_l(ddio_out_datain_l),

.outclock(clk),

.dataout(output_data)
);

endmodule

Example 5–2. Examples of Virtual Pins in the Top-Level HDL File

output[7:0]input_dataout_h /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
output[7:0]input_dataout_l /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
input[7:0]output_datain_h /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
input[7:0]output_datain_l /* synthesis altera_attribute="-name VIRTUAL_PIN ON" */;
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The synthesis attribute notifies the Quartus II software that these are virtual pins and 
that they should be connected to internal logic as the design is completed or finalized. 
These virtual pins would not be shown in the All Pins list or Groups in the Pin 
Planner as they are not the actual external ports of the design. The Pin Planner makes 
virtual pin assignments to internal nodes, so internal nodes are not assigned to device 
pins during compilation.

1 The top-level design file must be updated whenever changes are made to the design’s 
top-level ports, including any node changes made in the Set Up Top-Level Design 
File dialog box.

After you generate the top-level file in HDL, you can continue with your design flow 
to modify or create pin assignments using the Pin Planner.

Importing and Exporting Pin Assignments
After analysis and synthesis of your Quartus II project, you can transfer pin-related 
assignments between the Quartus II software and other tools by importing and 
exporting these assignments in the following file formats: Comma Separated Value 
(.csv) file, Quartus II Settings File (.qsf), Tcl (.tcl), FPGA Xchange (.fx) file, and 
Pin-Out (.pin) file (export only).

Spreadsheets and .csv Files
You can transfer pin-related assignments as a .csv file. This file consists of a row of 
column headings followed by rows of comma-separated data. The row of column 
headings in the exported file is in the same order and format as the columns displayed 
in the Pin category in the Assignment Editor or in the All Pins list in the Pin Planner. 
Do not modify the row of column headings if you plan to import the .csv file later.

To import a .csv file into your project, on the Assignment menu, click Import 
Assignments and browse to the file. 

You can export pin-related assignments from the Quartus II Pin Planner or the 
Assignment Editor. To export your pin-related assignments to a .csv file, on the 
Assignment menu, click Pin Planner or Assignment Editor. For the Pin Planner, make 
sure the All Pins list is visible. If the list is not visible, on the View menu, click All Pins 
List. For the Assignment Editor, from the Category list, select the Pin category. Then, 
to create the .csv file, on the File menu, click Export. 

1 The All Pins list in the Quartus II Pin Planner, the Pin category in the Quartus II 
Assignment Editor, and the device .pin files all display detailed properties about each 
pin of the device, in addition to the pin name and pin number. The device .pin files 
are available on the Altera website at www.altera.com.

Quartus II Settings Files
When you make pin assignments with the Pin Planner or the Assignment Editor in 
the Quartus II software, all your pin-related assignments are written to the Quartus II 
Settings File (.qsf). You can also export pin-related assignments to a .qsf file. The 
pin-related assignments are stored as Tcl commands in the .qsf file.
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To import a .qsf file, on the Assignments menu, click Import Assignments and 
browse to the .qsf file, or source the .qsf file in the Tcl console. To export a .qsf file, on 
the Assignments menu, click Export Assignments, type in a file name, and click OK. 
When you export assignments to a .qsf file, the .qsf file contains all the pin-related 
assignments along with other Quartus II project-related assignments.

f For more information about .qsf files, refer to the Managing Quartus II Projects chapter 
in volume 2 of the Quartus II Handbook.

Tcl Script
You can export pin-related assignments from the Quartus II Pin Planner or the 
Assignment Editor. To export pin-related assignments as a Tcl script, on the 
Assignments menu, click Pin Planner or Assignment Editor. For the Pin Planner, 
make sure the All Pins list is visible. If the list is not visible, on the View menu, click 
All Pins List. For the Assignment Editor, select the Pin category from the Category 
list. Then, to create the .tcl file, on the File menu, click Export. In the Export dialog 
box, type a file name, select Tcl Script File (*.tcl), and click OK. All pin-related 
assignments displayed in the All Pins list of the Pin Planner and the spreadsheet of 
the Assignment Editor are saved as Tcl commands in the Tcl script.

For more information about the All Pins list in the Pin Planner, refer to “Using the Pin 
Planner” on page 5–20.

To import the pin-related assignments from a Tcl script, source the Tcl script in the Tcl 
console or run the Tcl script with the quartus_sh executable. For example, type the 
following command at a system command prompt:

quartus_sh -t my_pins.tcl r

f For more information about Quartus II scripting support, including examples, refer to 
the Tcl Scripting and Command-Line Scripting chapters in volume 2 of the Quartus II 
Handbook. 

FPGA Xchange File
An .fx file contains device and pin-related information that allows you to transfer 
information between the Quartus II software and the Mentor Graphics I/O Designer 
software. To transfer pin information between the I/O Designer and the Quartus II 
software, use an .fx file. The .fx file format is imported with the *.pin file produced in 
the Quartus II software and I/O Designer. However, the Quartus II software requires 
only the .fx file to import back from the I/O Designer. 

f To learn more about the I/O Designer and the DxDesigner interface and support, 
refer to Mentor Graphics PCB Tools Support chapter in volume 2 of the Quartus II 
Handbook.

To import an .fx file into the Quartus II software, perform the following steps:

1. On the Assignments menu, click Import Assignments. 

2. In the File name box, click the browse button and click FPGA Xchange Files (*.fx) 
in the Files of type list. 

3. Select the .fx file and click Open.
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4. Click OK.

To generate an .fx file in the Quartus II software, perform the following steps:

1. Perform an I/O Assignment Analysis or a full compilation in the Quartus II 
software.

2. On the Assignments menu, click EDA Tool Settings. The Settings dialog box 
appears.

3. Select Board-Level. The Board-Level page appears.

4. Under Board-level symbol, in the Format list, select FPGA Xchange. 

5. Set the Output directory to the location where you want to save the file. The 
default output file path is <project directory>/symbols/fpgaxchange.

6. Click OK.

7. On the Processing menu, point to Start and click Start EDA Netlist Writer. 

The output directory you selected is created when you generate the .fx file using the 
Quartus II software.

.pin File
A .pin file is an ASCII text file containing pin location results and other pin 
information. To generate a .pin file for your project, you must successfully perform an 
I/O Assignment Analysis or full compilation in the Quartus II software. The .pin file 
of your project is written at the <project directory> level.

Use the .pin file to transfer your project’s pin information into third-party PCB tools 
for board development. Figure 5–13 shows an example .pin file, and Table 5–1 
describes the columns in a .pin file.

Figure 5–13. Example of a .pin File

Table 5–1. .pin File Header Description

Column Name Description

Pin Name/Usage The name of a design pin, ground, or power

Location The pin number of the location on the device package

Dir The direction of the pin

I/O Standard The name of the I/O standard to which the pin is configured

Voltage The voltage level that is required to be connected to this pin

I/O Bank The I/O bank number that the pin belongs to

User Assignment Y or N indicating if the location assignment for the design pin was user 
assigned (Y) or assigned by the Fitter (N)

Pin Name/Usage Location Dir. I/O Standard Voltage I/O Bank User Assignment

VCCA_PLL1 9 power   1.5V 
clk 10 input LVTTL  1 N      
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f For more information about Pin Name/Usage, refer to the Device Pin-Out tables for 
the targeted device, available on the Altera website at www.altera.com.

Creating Pin-Related Assignments
A pin-related assignment is any assignment applied to a top-level pin. For example, a 
pin location assignment is a pin-related assignment that assigns a top-level port or 
node to a pin number (location) on the targeted device. Other examples of pin-related 
assignments include assigning an I/O standard, assigning current drive strength, or 
assigning slew rates to a pin.

The recommended approach for making pin-related assignments is to have all the 
top-level pins in the Pin Planner and create pin-related assignments for these pins.

If you do not have complete information for all the top-level pins, you can reserve 
certain device pins to temporarily represent your top-level design I/O pins until the 
I/O pins are defined in your design files. Reserved pins are intended for future use 
but do not currently perform a function in your design. Reserved pins require a 
unique pin name and pin location. Using reserved pins as place holders for future 
design pins increases the accuracy of the I/O assignment analysis.

The Quartus II software offers many tools and features for creating reserved pins and 
other pin-related assignments (Table 5–2). Each tool and feature is described in more 
detail in the following sections.

Table 5–2. Overview of Quartus II Tools and Features to Create Pin-Related Assignments (Part 1 of 2)

Feature Overview

Pin Planner ■ Make pin location assignments to one or more node names by dragging and dropping unassigned 
pins into the Package View

■ Edit pin location assignments for one or more node names by dragging and dropping groups of pins 
within the Package View 

■ Visually analyze pin resources in the Package View 

■ Display I/O banks and VREF groups 

■ View the function of package pins using the pin legend

■ Make correct pin location decisions by referring to the Pad View window

■ Create, import, and edit megafunctions and IP MegaCore functions for early I/O planning

■ Generate a top-level wrapper file without design files based on early I/O assignments

■ Configure board trace models of selected pins for use in “board-aware” signal integrity reports 
generated with the Enable Advanced I/O Timing option

Assignment 
Editor

■ Create and edit all types of pin-related assignments

■ Create and edit multiple assignments simultaneously with the Edit bar

■ Create pin assignments efficiently by viewing the different font styles used to display assigned and 
unassigned node names, as well as occupied and available pin locations

■ Provides user-selectable information about each pin, including the pad number, tCO requirement, and tH 
requirement

Tcl ■ Create any pin-related assignments for multiple pins

■ Store and reapply all pin-related assignments with Tcl scripts

■ Make assignments from the command line
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Using the Pin Planner
The Pin Planner is the main interface for creating and editing pin-related assignments. 
Use the Pin Planner Package View to make pin location and other assignments using 
a device package view instead of pin numbers. With the Pin Planner, you can identify 
I/O banks, VREF groups, and differential pin pairings to help you through the I/O 
planning process.

When planning your I/Os, it can be cumbersome to try to correlate pin numbers with 
their relative location on the package and their pin properties. The Pin Planner 
provides an intuitive graphical representation of the targeted device, also known as 
the Package View, that makes it easy to plan your I/Os, create reserved pins, and 
make pin location assignments. When deciding on a pin location, use the Pin Planner 
to gather information about available resources, as well as the functionality of each 
individual pin, I/O bank, and VREF group. You can assign locations to design pins by 
dragging and dropping each pin into the Package View. 

1 Maintaining good signal integrity (SI) requires that you follow pad distance and pin 
placement rules. Complementing the Pin Planner is the Pad View window, which 
displays the pads in order around the silicon die.

The Pin Planner includes the following sections (refer to Figure 5–14 through 
Figure 5–19):

■ “Groups List” on page 5–21

■ “All Pins List” on page 5–24

■ “Pad View Window” on page 5–26

■ “Package View” on page 5–28

■ “Pin Migration View” on page 5–30

■ “Using the Pin Finder to Find Compatible Pin Locations” on page 5–33

■ “Creating Reserved Pin Assignments” on page 5–34

■ “Creating Pin Location Assignments” on page 5–35

■ “Changing Pin Locations” on page 5–42

■ “Show I/O Banks” on page 5–44

■ “Show VREF Groups” on page 5–45

■ “Show Edges” on page 5–47

■ “Show DQ/DQS Pins” on page 5–48

■ “Displaying and Accepting Fitter Placements” on page 5–49

Chip Planner or 
Timing Closure 
Floorplan

■ Create and change pin locations by dragging and dropping pins into the floorplan

■ Make correct pin location decisions by referring to the pad ID number and spacing

■ Display I/O banks, VREF groups, and differential pin pairing information

Synthesis 
Attributes

■ Embed pin-related assignments using attributes in the design files to pass assignments to the 
Quartus II software

Table 5–2. Overview of Quartus II Tools and Features to Create Pin-Related Assignments (Part 2 of 2)

Feature Overview
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The Pin Planner feature supports cross-probing that allows you to select a pin in one 
view while simultaneously highlighting the pin in all of the different views. For 
example, if you select a pin in the Package View of the Pin Planner, the corresponding 
pad in the Pad View window is highlighted. If the pin has an assigned node name, the 
node name in the All Pins list and the Groups list is highlighted.

The Pin Planner and the Assignment Editor get their I/O Bank colors from Timing 
Closure Floorplan colors, which you can customize by performing the following 
steps:

1. On Tools menu, click Options. The Options dialog box appears.

2. In the Category list, under Timing Closure Floorplan, select Colors. The Colors 
page appears.

3. Make your color selections and click OK.

Groups List
The Groups list displays all of the buses from the top-level pins of your design and all 
the assignment groups in your project (Figure 5–15). Filter the group names displayed 
by typing in a wild card filter into the Named list. The Groups list allows you to create 
your own custom groups of pins and make location assignments to groups by 
dragging them into the Package View of the Pin Planner.

Figure 5–14. Pin Planner 

All Pins List

Groups List Package View
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